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Lesson 9 — Analyze Financial Data Lesson Objectives

Lesson Objectives

Discuss some of the tools in QuickBooks for analyzing financial data: QuickReports, preset
reports and graphs

Create a QuickReport

Add a column to a report

Learn how to move a column in a report

Learn about the types of preset reports QuickBooks offers

Practice creating reports and viewing them onscreen

Customize a report by changing how it looks and the data it covers (filtering)
Learn how to process reports in batches

Save reports as portable document format (PDF) files

Learn how to export a report to Microsoft Excel®

Practice filtering reports in Excel

Learn about the types of graphs QuickBooks offers

Create and customize several graphs
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Lesson 9 — Analyze Financial Data Create QuickReports

Create QuickReports

One of the fastest ways to see a report on your QuickBooks data is to create a QuickReport.
QuickReports are predesigned reports that give you information about the list name you're currently
viewing on screen. Whenever you have a list, register or form displayed, you can click a button to
have QuickBooks create a QuickReport.

@
o0 Step-by-Step: See What You Owe a Vendor

1. Click Vendor Center on the icon bar.

Vendor Center: CalQil Company

New Vendor... ¥ New Iransactions ¥ (3 Print ¥ Excel ¥ word ¥ [ BilTracker
== <SZ 70 X!
== Vendor Informat 0 ¢
enaor Information * Lot
Active Vendors - > |
| | Company Name Main Phone 650-555-0912 No note available
yel | Full Name
: REPORTS FOR THIS VENDOR
= - Account o, 0B-4567-432
| name I BALANCE TOT... } ATTACH e Netds QuickReport
ACheung Limited 0.00 Siled From  Cal0il Company Open Balance
|| Bank of Anycity 0.00 d PO Box 628
Bayshore CalOil .. 0.00 | Middlzfield GA 84482
Bayshore Water 0.00 i Order Checks
| Bruce's Office W 0.00 | wap | Directions
C.U. Electric 750.00 |
| Cal Gas & Electric 122.68 i
| Cal Telephone 91.94 1 Transactions Contacts To Do's Motes Sent Email
‘ - | swow  All Transactions * | FERBY Al w  pare  This Fiscal Year | 01012022 - 1203112022
City of Bayshore 0.00 |
Gity of East Bays.. 0.29 | TYPE HE ipaTE v i ACCOUNT i AMOUNT .
City of Middlefield 0.00 7 Check 479 12/02/2022 10100 - Checking -135.80 l
' Custom Kitchen 0.00 | Check 457 11115/2022 10100 - Checking -48.28
Dalgle Lighting 1,591.00 T Check 422 101512022 10100 - Checking -6,534.28
| | Check 355 071512022 10100 - Checking -4,674.89
Davis Business ... 0.00
| Dianne's Auto Sh .00 | Check 336 06152022 10100 - Checking -9,164.00 -
|
East Bayshore A. 0.00 1
| i Manage Transactions v Run Reports v
East Bayshore T. 0.00 v |
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Lesson 9 — Analyze Financial Data Create QuickReports

2. Right-click on the vendor name you wish to run a report for and select QuickReport, or click on
the QuickReport hyperlink in the section.

Vendor QuickRepo

Customize Report Comment on Report Share Template Memorize Print = E-mail = Excel = Hide Header Refresh
[BEICCR This Month-to-date =  From 12/01/2022 B To 12/15/2022 [ SortBy Default -

Show Filters

Z33PM Rock Castle Construction

12115122 Vendor QuickReport

December 1 - 15, 2022
Type Date Num Memo Account Clr Split Debit Credit
CalQil Company
3 Check 12022022 479 10100 - Checking 20600 - Cal0... 135.80 4

3. You can expand the date range to capture more transactions on your QuickReport. You'll see
other ways to customize the QuickReport later in this lesson.
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Lesson 9 — Analyze Financial Data Zoom in on a QuickReport

Zoom in on a QuickReport

All QuickReports contain a summary of individual transactions. To help you better understand the
information presented in reports, QuickBooks lets you trace report data to the individual transaction
level using QuickZoom.

When you position the mouse pointer over a number in a report and see the QuickZoom symbol (a
magnifying glass with a Z in it), you can double-click the number to display the original transaction in
QuickBooks.

@
2! Step-by-Step: See more Detail about a Transaction

1. From any financial report, hold your cursor over the dollar amount/transaction you wish to view
in more detail.

2. When your cursor turns into the QuickZoom icon, double-click your mouse to zoom in. This will
open the transaction.

3. Press Esc to close the window.

NOTES
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Customize QuickReports

Each QuickReport window has a button bar at the top of the report for customizing report content
and layout.

Customize Report Comment on Report Share Template | Memorize Print |+ E-mail ~| Excel ¥ Hide Header Refresh
[BEICI This Month-to-date = From 12/01/2022 B To 12M5/2022 [ SortBy Default b4
]

2! Step-by-Step: Add a Column to a Report

1. Inthe QuickReport window, click Customize Report.

2. Inthe Columns list, select the additional columns you would like to add to the report (in this
example, we marked the Trans # column).

Modify Report: Vendor QuickReport

Display Filters Header/Footer Fonts & Numbers

REPORT DATE RANGE

Dates This Month-to-date *  From the first day of the current month through today

From | 12/01/2022 B To (12152022 [

COLUMNS
Search Columns Sortpy  Default -
S @ Ascending order &%
- A Sartin . ] =
< (left margin) () Descending order i
< Trans # m
< Type
EnterediLast Modified
Last modified by
+ Date
 Mum
Put a check mark next to each column
v that you want to appearin the report.

Revert
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Lesson 9 — Analyze Financial Data Customize QuickReports

3. Click OK to accept the change.

Vendor Quic
Customize Report Comment on Report Share Template Memorize Print =+ E-mail - Excel + Hide Header Refresh
[pEICER This Month-to-date *  From |12/01/2022 B To 12M15/2022 B8 SoriBy Default -
Show Filters
Z33PM Rock Castle Construction
12115/22

Vendor QuickReport

December 1 - 15, 2022
Type Date Num Memo Account Clr Eplit Debit Credit

Caldil Company

» 103% Check 12022022 475 10100 - Checking 20600 - Cal0.. 135.80 4

Notice the additional column(s) in your report.

@
9! Step-by-Step: Move a Report Column

1. Position your mouse pointer over the column you wish to move (the mouse becomes a hand).

2. Hold down the left mouse button and drag the column header/name to the position you would

prefer. When a red arrow appears, release your mouse button if you want the column to appear
in this new position.

QuickBooks 2018 Student Guide 10



Lesson 9 — Analyze Financial Data Customize QuickReports
]
o Step-by-Step: Change Information in the Report Heading

1. Inthe report window, click Customize Report then click the Header/Footer tab.

Madify Report: Vendor QuickReport

Display Filters Header/Footer Fonts & Mumbers
SHOW HEADER INFORMATION PAGE LAYOUT
7 ECompany Name§ Rock Castle Construction Alignment
. - Standard -
+ Repor Title Wendor QuickReport
« Sublitle December 1- 15, 2022 Time Company
g:;ies Title

+| Date Prepared 12131401 - Subtitle

7 Time Prepared —

~ Print header on pages after first page n
i
i

SHOW FOOTER INFORMATION

507152

« Page Number Page 1 - Extra Line Page

« Extra Footer Line

~ Print footer on first page

Revert

On the Header/Footer tab you can change the company name, report title, subtitle, and date
and time prepared. You can also specify whether to print the header on all pages or just the first
page. The Header/Footer tab is the same for all QuickBooks reports.

2. Highlight the text in the Report Title field and replace it with the title you would like.
3. Click OK to close the Modify Report window.

4. Close the report.

= IMPORTANT: To save this report for future use, click the Memorize button on the report tool bar before
closing the report. This allows you to save the custom settings and run the report with the new settings
at a later date from the Reports drop-down menu.

NOTES
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Lesson 9 — Analyze Financial Data

Use the Report Center

Use the Report Center

A good way to learn about the reports available in QuickBooks — and how to work with them — is the

Report Center.

The Report Center contains a description and example of each QuickBooks report. You can click the

icons at the top right corner of the Report Center to select the display format you prefer.

]

2!  Step-by-Step: Learn More about Reports

1. Click Reports on the icon bar (or under the Reports menu), and then click Report Center.

2. Use the blue view icons in the top right corner to customize your view.

Report Center

Company & Financial

Customers & Receiva.
Sales

Jobs, Time & Mileage
Vendors & Payables
Purchases

Inventory

Employees & Payroll
Banking

Accountant & Taxes
Budgets & Forecasis
List

Contractor

Mig & Wholesale
Professional Services
Retail

Nonprofit

Standard Memorized

Favorites Recent Contributed

Company & Financial

Profit & Loss (income statement)

Profit & Loss Standard

Profit & Loss Detail

Profit & Loss YTD Comparison

Pront & Luss Standard Company & Francal
ey e
0105 - Comiucton locome R
0500 - emurmert Inome
Toia Incrme B
ot of oo Sad.
50105 - Cost o ot S0 208
51000 - 3o Expemaes LT
s o5 e}
G Froft: memm
Epene
200 Fegais 7500
1500 Fogt.ang Macrinery e
Tora e 50
4 Cravary Income 196185
e ncome oo
Gthor incame
T0U05 - Dtrer Income: 4as
Tow e income 43
et Other Income e
et Inceme e

e am s

i

E
E Ekbkk: stk
EERLE gk
[

[——

s enk M mamm s
Tt b HEDN e amwn mna
ok st

Gatrosson 26 (Ll ias ey
[ L | ihals nesm
it Sen  mmiw  WrMs ses
s mm mm o

M G L s
T s i RS B R
ey e, W W AL
i et
o

ey wa W oma
7 B e br v
o lew  tw  lam e

WS oWl wein sdvw

Dates: This Month-to-date ~
1200122 1215022

OH @9 @

Dates:  This Fiscal Year-to-date

10122 12015722

OH @9 @

Dates:  This Month-to-date ~
120122 1215022

OH @@

GRID VIEW
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Lesson 9 — Analyze Financial Data Use the Report Center

Standard Memorized Favorites Recent Contributed Search

Company & an

Company & Financial

Profit & Loss (income statement)

Customers & Receiva.

Sales

Profit & Loss Standard
Jobs, Time & Mileage

How much money did my company make or lose over a specific period of time?
Vendors & Payables

Purchases QO H 9 O | Dates This Monthto-date » 12001722 1211502
Inventos

& Profit & Loss Detail
Employees & Payroll What are the year-io-gate fransactions (and toials) for each income and expense account, so | can determine what confributed to my company's

Banking AR

Accountant & Taxes
0 ﬂ @ 0 | Dates: This Fiscal Year-fo-date =  101/22 12115122

Budgets & Forecasts
Profit & Loss YTD Comparison

List

How do my income and expenses for a recent peried of time compare to the entire fiscal year to date?
Contractor
Mfg & Whalesale Q E @ @ | paes Thsmonintodate - 120122 1201522

Professional Services Profit & Loss Prev Year Comparison

Retail |z my company making more money now than for the same period a year ago?

Nonprofit
™ = an | Pmbns T Mt Vs e min pimemn amin

LIST VIEW

il Report Center

Standard Memorized Favorites

Company & Financial

Profit & Loss Standard

Customers & Receiva .
How much money did my company make or lose over a specific period of time?

Sales
Jobs, Time & Mileage Profit & Loss Standard
Vendors & Payables Ordinary Income/Expense
Income
40100  Construction Income: 39,24.16
Purchases 40500 - Roi e 000
932416
Inventory
2,013.67
Employees & Payroll
20,603.03
Banking
175.00
Accountant & Taxes 985.00
1961803
Budgets & Forecasts
Income
L 70100 - Other Income: 25
ist Total Other Income 4151
Net Other Income 353
Contractor Net Income 19,661.56

Mfg & Wholesale

Professional Services

Y
Dates: This Month-fo-date ~ 12/0122  12/1522 g 2
Retail Run Fave Help

Nonprofit

CAROUSEL VIEW

3. Click the Contributed tab to open Contributed Reports, an Intuit web page where you can
search, review, download and import additional reports. Review the information, and then close
the window.
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Lesson 9 — Analyze Financial Data Create a Balance Sheet Previous Year Comparison Report

Create a Balance Sheet Previous Year
Comparison Report

The balance sheet comparison report compares the current year against the previous year in both
dollar amount and percentage.

@
2! Step-by-Step: Create a Balance Sheet Previous Year Comparison Report

1. Inthe Report Center, click on the Standard tab and choose Company & Financial, scroll down
and choose Balance Sheet Prev Year Comparison.

2. Click the Runicon.

Balance Sheet Prev Year Comparison

Customize Report Comment on Report Share Template Memorize Print + E-mail * | Excel - Hide Header Collapse Refresh
[DEICERM This Fiscal Year-to-date ~  Asof 1215/2022 HE Show Columns ~ Total only * SortBy Default v
Report Basis: (® Accrual () Cash Show Filters
2:48 PM Rock Castle Construction
12118122 Balance Sheet Prev Year Comparison
Accrual Basis As of December 15, 2022
Dec 15,22 Dec 15, 21 % Change % Change
T ASSETS
¥ Current Assets
¥ Checking/Savings
10100 - Checking 3 4479910 4 35,850.57 793853 21.5%
10300 - Savings 1791019 15,808.564 2,101.55 13.3%
10400 - Petty Cash 500.00 500.00 0.00 0.0%
Total Checking/Savings 63,209.29 53,169.21 10,040.08 12.9%
¥ Accounts Receivable
11000 - Accounts Receivable 93,007.93 20,841.04 72,166.89 346.3%
Total Accounts Receivable 93,007.93 20,841.04 72,166.89 346.3%
¥ Other Current Assets
12000 - Undeposited Funds 2,440.00 20,252.08 -17,812.08 -B8.0%
12100 - Inventory Asset 30,683.38 12,767.04 17,918.34 140.3%
12800 - Employee Advances &32.00 7r0.00 §2.00 81%
13100 - Pre-paid Insurance 4,050.00 5,081.85 -1,041.85 -20.5%
13400 - Retainage Receivable 3,703.02 1,796.72 1,906.30 106.1%
Total Other Current Assets 41,708.40 40,677.69 1,030.71 25%
Total Current Assets 197,925.62 114,687.94 83,237.68 T26%
¥ Fixed Assets
15000 - Furniture and Equipment 34 326.00 22 826.00 11,500.00 50.4%

Scroll the report window to see more of the report.
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Lesson 9 — Analyze Financial Data Create a Balance Sheet Previous Year Comparison Report
3. Click the Collapse button in the top right section of the report to see the difference.

The Collapse button hides subaccounts, jobs and subclasses. Amounts are summarized under
the parent account. This button affects both the onscreen and printed report.

4. Click Expand in the top right section of the report (where the Collapse button had been) to
return to the original report display.

5. Close the report.

NOTES
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Lesson 9 — Analyze Financial Data Filter Reports

Filter Reports

You can customize reports in QuickBooks to highlight just the information you're interested in

getting. In this exercise, you'll customize the balance sheet comparison report and filter it to include
only the transactions you specify.

Report filters let you set custom criteria for the transactions you want included in a report. When you
filter a report, QuickBooks includes only those transactions that match the rules you create.

@
2! Step-by-Step: Filter a Preset Report

1. With the Balance Sheet Prev Year Comparison report displayed, click Customize Report on the
Report button bar.

2. Click the Filters tab.

Modify Report: Balance Sheet Prev Year Comparison

Display Filters Header/Footer Fonts & Numbers

CHOOSE FILTER CURRENT FILTER CHOICES

Search Filters Account FILTER SET TO
Date This Figcal Year-t...

; : Al accounts -

: A
éﬁ\ging l
EAmount
%B—Da].r
iBilling Status N
v

Remove Selected Filter
ACCOUNT FILTER

Choose the types of accounts or a specific account from the

drop-down list. Indicate whether or not you want split detail
to appearin the report (Balance Sheet accounts only).

Tell me more...
Revert

3. Inthe Filter scroll box, choose the filters for which you want to set your parameters and set your
specifications.
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Filter Reports

4. Toremove or modify a filter, highlight it in the Current Filter Choices section, and either modify
the filter or click Remove Selected Filter.

5. Click OK.

6. You can review what filters have been applied directly on any particular report by clicking Show
Filters in the top left corner of the displayed report. Once you have done that, you can click on a
filter to change it, or click on the X next to the filter to remove it. When printed, reports with
Applied Filters displayed will print the filters on a separate page. You can also click Hide Filters
(where the Show Filters button had been) to hide the list of filters.

Balance Sheet Prev Yea

omparison

Customize Report Comment on Report Share Template Memorize Print * E-mail ¥ Excel - Hide Header Collapse Refresh
Dates is Fiscal Year-to-date *  Asof 12152022 E Show Columps  Total only * Sort By Default -
Report Basis: @ Accrual () Cash Show Filters
248 PM Rock Castle Construction
1218022 Balance Sheet Prev Year Comparison
Accrual Basis As of December 15, 2022
Dec 15, 22 Dec 15, 21 § Change % Change
T ASSETS
¥ Current Assets
¥ CheckinglSavings
10100 - Checking 4475510 4 36,860.57 793853 21.5%
10300 - Savings 17,910.19 15,2808 .64 2,101.55 13.3%
10400 - Petty Cash 500.00 500.00 0.00 0.0%
Total CheckingiSavings 63,209.29 53,169.21 10,040.08 18.9%
¥ Accounts Receivable
11000 - Accounts Receivable 93,007.93 20,841.04 72,166.89 346.3%
Total Accounts Receivable 93,007.93 20,841.04 72,166.89 345.3%
¥ Other Current Assets
12000 - Undeposited Funds 2,440.00 20,252.08 -17,812.08 -88.0%
12100 - Inventory Asset 30,683.38 12,767.04 17,916.34 140.3%
12800 - Employee Advances 832.00 TT0.00 §2.00 8.1%
13100 - Pre-paid Insurance 4,050.00 5,081.85 -1,041.85 -20.5%
13400 - Retainage Receivable 3,703.02 1,796.72 1,905.30 105.1%
Total Other Current Assets 41,708.40 40 677.69 1,030.71 2.5%
Total Current Assets 197 92562 114,687.94 83,237.68 T2.6%
¥ Fixed Assets
15000 - Furniture and Equipment 34 326.00 22 825.00 11,500.00 50.4%

QuickBooks 2018 Student Guide
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Lesson 9 — Analyze Financial Data Filter Reports

Year Comp:

Customize Report Comment on Report Share Template Memorize Print * E-mail v | Excel |~ Hide Header Collapse Refresh

= Asof 12M5/2022 @ Show Columps  Total only ~ SortBy Default -

Report Basis: @ Accrual () Cash Hide Filters | Date: This Fiscal Year-t%:ate x |

2:45 FM Rock Casfle Construction
1211822 Balance Sheet Prev Year Comparison
Accrual Basis As of December 15, 2022
Dec 15, 22 Dec 15, 21 § Change % Change
¥ ASSETS

¥ Current Assets

¥ Checking/Savings

10100 - Checking ] 4479910 4 36,860.57 7,938.53 21.5%
10300 - Savings 17,910,198 15,808.64 2101.55 13.3%
10400 - Petty Cash 500.00 500.00 0.00 0.0%
Total Checking/Savings 63,209.29 53,169.21 10,040.08 18.9%
¥ Accounts Receivable
11000 - Accounts Receivable §3,007.93 20,841.04 72,166.89 346.3%
Total Accounts Receivable 93,007.93 20,841.04 72,166.89 346.3%
¥ Other Current Assets
12000 - Undeposited Funds 2,440.00 20,252.08 -17,812.08 -58.0%
12100 - Inventory Asset 30,683.38 12,767.04 17,916.34 140.3%
12800 - Employee Advances a32.00 770.00 62.00 2.1%
13100 - Pre-paid Insurance 4,050.00 5,091.85 -1,041.85 -20.5%
13400 - Retainage Receivable 3,703.02 1,795.72 1,908.30 106.1%
Total Other Current Assets 41,708.40 40 677.69 1,030.71 2.5%
Total Current Assets 197,925.62 114,687.94 83,237.68 T2.6%
¥ Fixed Assets
15000 - Furniture and Equipment 34,325.00 22 825.00 11,500.00 50.4%

NOTES
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Lesson 9 — Analyze Financial Data Save Reports as a PDFs

Save Reports as PDFs

To keep a record of the information in the report as it exists today, you can save the report in
portable document format (PDF).

@
2! Step-by-Step: Save a Report as a PDF File

1. With the report open, choose Save as PDF from the File menu. (You can also click on Print >
Save as PDF.)
2. Navigate to the folder where you want to store the PDF and enter a file name.

3. Click Save.

4. Close the report window.

= IMPORTANT: if you wish to send the report as a PDF attachment to an email in one step without saving it
as a PDF first, select Email > Send report as PDF. (QuickBooks will not allow you to select the Send
report as PDF option if you are using a sample company.)

NOTES
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Lesson 9 — Analyze Financial Data Use QuickZoom in a Report

Use QuickZoom in a Report

1.

@
2! Step-by-Step: QuickZoom on a Listing in a Report

Position the mouse pointer over the listing you wish to view in detail.

2. Double-click the amount.

What you see when you QuickZoom in a report will depend on the type of report displayed:

® Ifthe report shows summary figures (like the Sales by Customer Summary report below) and
you QuickZoom an amount...

stomer Sum mary

Customize Report Comment on Report Share Template Memorize Print * | E-mail » | Excel - Hide Header | Collapse Refresh

[nEA LI This Month-to-date * From 12/01/2022 B To 12152022 [E Show Columns Total only * Sort By Default -

Report Basis: (@ Accrual () Cash Show Filters

513 PM Rock Castle Construction
1211822 Sales by Customer Summary
Accrual Basis December 1 - 15, 2022
Dec 1-15,22
¥ Abercrombie, Kristy
Remodel Bathroom » 3,862.00 4
Total Abercrombie, Kristy 3,362.00
¥ Campbell, Heather

Remodel 13,800. e
Total Campbell, Heather 13,900.00
~ Cook, Brian
Kitchen 1,528.45
Total Cook, Brian 1,528.45
¥ Keenan, Bridget
Sun Room §5.00
Total Keenan, Bridget 55.00
¥ Lew Plumbing - C
Storage Expansion 220,00
Total Lew Plumbing - C 220.00
¥ Natiello, Ernesto
Kitchen 13,207.66
Total Natiello, Ernesto 13,207.66

 Nguyen, Tuan

Garane 3752
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Lesson 9 — Analyze Financial Data Use QuickZoom in a Report

... QuickBooks displays a detail report that includes the transactions which contribute to that
amount. You can then double-click on an individual transaction in that detail report to
QuickZoom on it.

tomer Detail

Customize Report Comment on Report Share Template Memorize Print v E-mail ~ Excel v Hide Header Refresh

pates I - Fom 120012022 B To 12152022 B SortBy Default .

Report Basis: ® Accrual () Cash Show Filters

6:13 PM Rock Castle Construction
12118122 Sales by Customer Detail
Accrual Basis December 1 - 15, 2022
Type Date Hum Memo Hame Item Gty uim Sales Price Amount Balance

Campbell, Heather

Remodel
» Invoice 12102022 1082 Floor plans Campbell, Heather.. Floor Pla... 20 150.00 3,000.00 4

Invoice 12Mznzz2 1082 Installation la...  Campbell, Heather... Installati... 150 §0.00 5,000.00 12,000.00
Invoice 12Mznzz 1082 General Labor  Campbell, Heather... Labor 30 50.00 1,500.00 13,500.00
Invoice 12102022 1082 Removal labor  Campbell, Heather... Remova... 10 40.00 400.00 13,%00.00

Total Remodel 210 13,900.00 13,%00.00

Total Campbell, Heather 210 13,900.00 13,%00.00
TOTAL 210 13,900.00 13,900.00

® If you QuickZoom a transaction in a detail report, QuickBooks opens and displays the invoice,
bill or other form for the requested transaction. At this point you can review, delete or edit
the displayed transaction as necessary.

Main Formatting Send/Ship Reports 2o
&P a E P74 CreateaCopy @ E = Print Later @ [ Acd TimeiCosts BR  Blcreate abaten
Find New Save Delete §BMemorize Mark As Print  Email Email Later | Attach | @ Apply Credits Receive B Refund/Credit
M - Pending M - File Payments
. —— e T =l P R
: mode il Rocx caste e~ SRS SIS S
—— | B
- | B
| nVOICE el BILLTC swpTo (ShIPTO 1 s .‘; Z
1210/2022 B Heather Campbell Heather Campbell 'i\ SUMMARY
- 98342 Sharondale Rd. 98342 Sharondale Rd. | |
INVOICE 2 | %
Millorae, CA94030 Milbrae, CA94030 jj Frone 650-555-3423
1092 | Email hcampbell@myemail.com
| |
_'E Preferred delivery method None
TERMS DUE DATE r: Open balance 13,900.00
Net 15 v |12/2512023 @& g{ Active estimates 0
| Sales Orders to be invoiced 0
ITEM ! DESCRIPTION L QUANTITY © um i RATE { AMOUNT b TAX \
Floor Plans Floor plans 20 150.00 3,000.00 Mon A ;f
Installation Installation labor 150 60.00 9,000.00 Mon l ri CUSTOMER PAYMENT &
| |
Labor General Labor 30 50.00 1,500.00 Non ‘s Your customer can not pay online
Remaoval Removal labor 10 40.00 400.00 Non F Edit customer preferences
[ ]
¥ i 8
's RECENT TRANSACTION <
SanTomas v | 12M0i22 Invoice 13,900.00
our customer can't pay this invoice online &% |San Tomas v (7.75%) 0.00 | | !
Tum on o 13,900.00 |
CUSTOMER MESSAGE PEYMENTS APFLIED 0.00 | |
| notes ¢
- BALANCE DUE 13,900.00 S
|
MEMO CUSTOMER | Tax - Save & Close Revert Fl

NOTES
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Memorize Reports

You may want to memorize reports which you customize, filter and run frequently. Memorizing
reports can save you from spending time customizing the same reports over and over again.
Remember, memorizing reports saves your customizations and filters, not the data. As new data is
entered or existing data is changed, running a memorized report will display the refreshed data but
with the same settings (e.g., columns, title, etc.) you saved.

@
9! Step-by-Step: Memorize a Report

1. When you are in a report you would like to memorize, click Memorize from the report tool bar.

ICustomizeReport Comment on Report Share Template II'."Iemori;eI Print |+ | E-mail *  Excel - Hide Header | Collapse Refresh

2. Name the memorized report accordingly.

3. Click the Save in Memorized Report Group checkbox if you would like to assign this report to a
group (you'll see more about memorized report groups in the next section), then choose the
group from the drop-down menu.

Memonze Report

Mame: Sales by Customer Detail

+| Save in Memaorized Report Group: Customers
+| Share this report template with others SEELLEL
Banking
- Customers
Accrual Basis
Employees
Type
Vendors

Abercrombie, Kris

4. Check the box next to Share this report template with others if you wish to offer this
memorized report (the settings, not the data!) to the entire Intuit community to help others who
may have a need for business information similar to yours in their own QuickBooks company
files.
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5. Click OK to memorize the report.

6. Close the report.

NOTES
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Create Memorized Report Groups

In addition to memorizing individual reports to save report settings, you can create memorized
report groups to organize your memorized reports in a way that makes sense for your business and
allows you to process a group of reports all at once.

QuickBooks comes preset with a number of memorized report groups, each already populated with
common reports for each area. You can add your own reports to these groups, modify the groups to
meet your needs and even create your own groups.

@
2!  Step-by-Step: Create a Memorized Report Group

1. Choose Memorized Reports from the Reports menu then choose Memorized Report List.

Memorized Report List

REFORT NAME

Accountant

+Balance Sheet
+General Ledger
+Journal Entries Entered Today
+Profit & Loss
+Trial Balance
+ Banking
+Check Detail
+Deposit Detail
> Company
+Balance Sheet
+Profit & Loss
+Statement of Cash Flows
+ Customers
+AR Aging Summary
+Customer Balance Detail
+Customer Balance Summary

+0Open Invoices

Memorized Report Display... Print... Export...

2. Inthe Memorized Report List, click the Memorized Report menu button, and then choose New
Group.

3. Inthe Name field of the New Memorized Report Group window, type Year End.

4. Click OK.
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Print Reports

@
2!  Step-by-Step: Print a Report

1. With a report open, click the Print button from the tool bar then choose Report.

Print Reports
Settings ~ Margins
@ Printer: HP Laserlet Pro MFP M127fw on WSD-04b__ Options... Cancel
) Filg: ASCI text file -
Help
Mote: To install additional printers or to change port
assignments, use the Windows Control Panel. Preview
ORIENTATION: PAGE RANGE:
@ Portrait ® Al
i Landscape ) Pages:
From: | To: 94944
PAGE BREAKS: MWumber of copies: 1
[+ Smart page breaks (widow/orphan control) [+ Collate
| Page break after each major grouping
| Fitreportto 1 page(s) wide ] Printin color (color printers only)
|:| Fit repclrttﬂ i page(s}mgh

2. Click Preview to see how the report will look when you print it.

QuickBooks displays a preview of your report onscreen.
3. Click Print.

4. Close the report.

NOTES
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Process Reports in Groups

]

2!  Step-by-Step: Batch Process Reports in a Group

1. Inthe Memorized Report List, select the report group you would like to print.

2. Click Display.

Process Reports in Groups

QuickBooks opens the Process Multiple Reports window. You can use this window to display or
print the selected reports (selected by the checkmark in the far left column next to the reports).
You can also change the date range for reports in this window before you display or print them

by changing the information in the From or To columns.

; Multiple Reports

1 Commented Reports

Select Memaorized Reports From  Accountant -

Choose the reporis to process, then press Display, Print or Email.

REFCRAT DATE RANGE FROM TO
« Balance Sheet This Fiscal Year-to-date 01/01/2022  12M5/2022
« General Ledger This Month-to-date 1200102022 121512022
» Journal Entries Entered Today Today 12MB2022  12M512022
« Profit&Loss This Month-to-date 120012022 121502022
« Trial Balance This Month-to-date 12001/2022 12M5/2022
5 report(s) selected m Print Email Cancel Help

FY

3. Selectthe reports you wish to print and click Display to review the information in the reports, or

click Print to print the reports.

If you chose to display the reports, you can print each report individually. Click the Print button from

that report’s tool bar, and then choose Report.

NOTES
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Process Multiple Miscellaneous Reports

In addition to batch processing a group of reports, you can also batch process various selected
memorized reports that are not all in the same report group.

@
9! Step-by-Step: Batch Process Multiple Miscellaneous Reports

1. From the Reports menu, select Process Multiple Reports.

2. QuickBooks opens the Process Multiple Reports window. Select the memorized reports you want
to process (all reports from all groups are currently listed) by placing a checkmark next to the
desired reports. You can also change the date range for reports in this window before you
display or print them by changing the information in the From or To columns.

5 Multiple Reports

® Memaorized Reparts ) Commented Reparts

Select Memorized Reports From  =All Reporis= -

Choose the reports to process, then press Display, Print or Email.

REFPORT DATE RAMGE FROM TO
» Customers:Open Invoices Today 12/15/2022 1201512022 A
+ Customers:Sales by Customer Detail This Month-to-date 1200102022 1211502022
Employees:Payroll item Detail This Month 12/01/2022  12/31/2022
Employees:Payroll Liabilities Custom 01/01/2003 1143002003
Employees:Payroll Summary This Month-to-date 12/01/2022  12/15/2022
v Missing Invoices Al
Profit & Loss by Job All
Vendors:AP Aging Summary Taday 12512022 121502022
i Vendors:Unpaid Bills Detail Today 12M15/2.. B 121520 @ |l
Vendors:Vendor Balance Detail All

A

4 report(s) selected m Print Email Cancel Help

3. Once the desired reports are selected, choose Display to review the information in the reports
or Print to print the reports.

If you chose to display the reports, you can print each report individually. Clicking the Print button
from that report’s tool bar, and then choose Report.
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Send a Report to Excel

Occasionally you may want to change a report’s appearance or contents in ways that aren't available
in QuickBooks, filter report data in ways you can't in QuickBooks, or run “what-if" scenarios on your
QuickBooks data.

You can send reports from QuickBooks to Excel. Since the changes you make in Excel don't affect
your QuickBooks data, you're free to customize reports as needed and even change data to run
“what-if” scenarios.

@
9! Step-by-Step: Send a Report to Excel

1. From the Reports menu, open the report you would like to convert to Excel.

2. Onthe Report button bar at the top of the report, set the date parameters for your report. You
can use the Customize button to set additional filters and add additional customization.

3. Ifyou clicked on the Customize button in the previous step, after you've specified your
additional parameters, click OK.

4. On the Report button bar, click Excel and Create New Worksheet (or you could select Update
Existing Worksheet if this report with these settings was previously sent to a spreadsheet that
was saved).
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5. Click the Advanced tab to add custom export options of Auto Outline and Auto Filtering if
they're not chosen already.

Advanced Excel Options

QuickBooks Options:
Keep the following format options from QuickBooks:

~| Eonts Space between columns

+| Colors +| Row height

Excel Options:
Turn on the following Excel features:

b

AutoFit (set column width to display all data)
+| Freeze panes (keep headers and labels visible)
+| Show Gridlines
+| Auto Qutline (allows collapsing / expanding)
| Auto Filtering (allows custom data filtering)
+| Include QuickBooks Export Guide waorksheet with helpful advice
Create backup worksheet during update
Printing options:
Show report header:
® On printed report only
7 On printed report and screen
+| Repeatrow labels on each page

6. Click OK, and then click Export.
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Create an Income and Expense Graph

If you want your business to be profitable, you need to keep an eye on your expenses. The income

and expense graph shows exactly what you're spending and where.

You should be especially concerned with the proportion you're spending on expenses relative to the

income you receive. As a simplistic example, if you're earning only $20,000 in income, you don't

want to spend $30,000 in expenses.

@
9! Step-by-Step: Create an Income and Expense Graph

1. From the Reports menu, choose Company & Financial then choose Income & Expense Graph.

You will see the top 10 expense categories listed with numerical information next to a key listing

them with their pie chart colors.

ight: Income and Expense Graph

Dates... By Account | By Customer | By Class Next Group Print... Refresh
Income and Expense by Month W Income
January 1through December 15 2022 M Expense
5in 1,000
70
60
50
40
ao
20
10
Jan 22 Mar 22 May 22 Jul 22 Sep22 Nov 22
Feb 22 Apr22 Jun 22 Aug 22 Oct22 Dec1-15 22
Expense Summary 1 54000 - Job Expenses 48.02
January 1 through December 15, 2022 M 62700 - Payroll Expenses 356
62100 - Insurance 5.0
M 50100 - Cost of Goods Sold 4.3
M 60100 - Automabile 2.0
W 54300 - Tools and Machinery 0.8
65100 - Utilities 0.6
M 52400 - Interest Expense 0.5
M 54200 - Repairs 0.49
M 53300 - Printing and Reproduction 0.43
W Other 0.14
Total §337,972.41
By Account
Show on Pie Chart | Income Expense

2. You can choose to categorize expenses By Account, By Customer or By Class from the report

tool bar at the top.
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3. QuickBooks can display information on only 10 pie segments at a time. To display more
accounts, click the Next Group button at the top of the graph window.

4. You can change the date range by clicking on the Dates button at the top.

@
2! Step-by-Step: Display Income Accounts Instead of Expense Accounts

1. Click Income at the bottom of the graph window.

2. Choose to categorize income By Account, By Customer or By Class from the report tool bar at
the top.

Quicklnsight: Income and Expense Graph

Dates... By Account | By Customer By Class Next Group Print... Refresh
Income and Expense by Month B Income
January 1 through December 15, 2021
5in 1,000
40
a0
20
10
Jan 21 Mar 21 May 21 Jul 21 Sep 21 Mov 21
Feb21 Apr21 Jun 21 Aug 21 Oct21 Dec1-15,21

Income Summary W Sage, Robert £.00%

January 1 through December 15, 2021 M Rahn Jennifer 5.80

Tony's Barber Shop 578

M Carr's Pie Shop 543

W Allard, Robert 540

M Davies, Aaron 531

Mackey's Mursery and Garden Supply 5.06

M Campbell, Heather 5.06

M Larsen's Pet Shop 5.06

M Samuels Art Supplies 5.06

W Other 4572

Total $274,450.01

By Customer

Show on Pie Chart  Income  Expense

NOTES
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Use QuickZoom with Graphs

To help you better understand the information shown in the graphs, QuickBooks lets you trace
graphical data using QuickZoom. This works the same as the QuickZoom functionality on report
entries described earlier in this lesson.

@
2! Step-by-Step: QuickZoom on Graphical Information

1. Position the mouse pointer over the section of the chart you wish to see in more detail and
double-click.

= IMPORTANT: The QuickZoom report features will vary depending on the type of information you are
choosing to QuickZoom in order to get more details.

5.} QuickZoom Graph -0 %

Next Group Print...

Income Summary I Fisher, Jennifer 327%
January 1 through December 15, 2022 M Jaccbsen, Doug 3.08
Luke, Moelani 302

W Baker, Chris 272

M Smith, Lee 237

M Burch, Jason 228

Violette, Mike 203

M Castillo, Eloisa 1.83

M Robson, Darci 1.81

M Teichman, Tim 172

Hl Cther 16.39

Sub-Total 549 05996

By Customer
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Customize How Graphs Display

You can customize graphs to control what data they include and how the data is displayed. In this
exercise you'll change the display from three-dimensional (3D) to two-dimensional (2D) graphs.

@
o Step-by-Step: Change from 3D to 2D

1. From the Edit menu, choose Preferences.
2. Inthe left panel, click Reports & Graphs.

3. Inthe My Preferences tab, place a checkmark in the box next to Draw graphs in 2D (faster).

" Daon'trefresh
tems & Inventory :

Click Help for information about

Jobs & Estimates. .
refreshing a large report.

Multiple Currencies

Preferences
E?f'f’ Accounting A My Preferences Company Preferences “
B sis . . . Cancel
M Calendar Prompt me to modify report options before opening a report
) Hel
EZ checking REFORTS AND GRAFHS GRAPHS ONLY .
®8%  Desktop View When a report or a graph needs to be | Draw graphs in 2D (faster} Default
Finance Charge refreshed: Use patterns
@ General 1 Prompt me to refresh Also See:
- ® Refresh automatically
zl Integrated Applications Ceneral
|

Payments

Ef, Payroll & Employees
=R .

LA Reminders

Reporis & Graphs

m Sales & Customers

fﬁ Sales Tax
p Search
E Send Forms

% Service Connection
Speling

4. Click OK.

5. Open the Report Center.
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6. Choose Sales then Sales Graph to view the effect of the change.

7. Click the Run (Display Report) icon.

8. Close the graph.

9. Close the Report Center.

NOTES
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Analyze Financial Data - Review Questions

1. is the tool that allows you to drill down on summary reports and
graphs in QuickBooks.

2. When can you generate a QuickReport?
a. Only when viewing an active customer or account
b. Only when viewing a list, register or form
c. Only atthe end of the current fiscal period
d. Only when viewing balance sheet accounts
3. In which report category would you find a list of open invoices?
a. Company & Financial
b. Sales
c. Customers & Receivables
d. List

4. Report let you set custom criteria for the transactions you want to
include in a report.

5. Once you've customized a preset report to meet your needs, how can you save your settings so
you don't have to customize the report each time you run it?

a. Choose Save Settings from the Report menu
b. Choose Save Setting from the File menu

c. Click Memorize on the button bar

d. Click Modify then choose Memorize

6. True or false: Once you've exported report data to Excel, you can send modified data back to
QuickBooks.

a. True

b. False
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Review Activities

1. Create a QuickReport on a name in one of Rock Castle Construction’s lists.

2. Rock Castle Construction wants to create a report that shows how much they have spent on
lumber for projects during November of the current year (the current year is whatever Rock
Castle Construction specifies is the current year based on the date you see when you open that
sample company). Create an item summary purchase report covering the date range for
November of the current year. Filter the report to show only Rock Castle Construction’s
purchases for lumber.

3. Batch process the balance sheet, profit and loss statement, and statement of cash flows using the
Process Multiple Reports window.

4. Use the Report Center to find reports that show the following:

® Sick and vacation balances for each employee

Time spent on each job

Inventory stock on hand and reorder point

Customers with overdue payments, how much they owe and their phone numbers

How much of total sales is taxable, at what rate, and how much sales tax is currently due
to be paid
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Answers to Review Questions

1. QuickZoom is the tool that allows you to drill down on summary reports and graphs in

QuickBooks.
2. When can you generate a QuickReport?
a. Only when viewing an active customer or account
b. v Only when viewing a list, register or form
c. Only at the end of the current fiscal period

d. Only when viewing balance sheet accounts

3. In which report category would you find a list of open invoices?

a. Company & Financial
b. Sales
c. v Customers & Receivables

d. List

4. Report filters let you set custom criteria for the transactions you want to include in a report.

5. Once you've customized a preset report to meet your needs, how can you save your settings so

you don't have to customize the report each time you run it?

a. Choose Save Settings from the Report menu
b. Choose Save Setting from the File menu
c. v Click Memorize on the button bar

d. Click Modify then choose Memorize

6. True or false: Once you've exported report data to Excel, you can send modified data back to

QuickBooks.
a. True
b. v False
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